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Overview

Terminoloqgy

.cfg file: The .cfg file is the TI-RTOS configuration file. It allows a user to fine-tune TI-RTOS to meet their
specific applications needs. It can be edited as a text file or graphically in CCS.

Platform: Everything you need to link. Supplied in TI-RTOS.
Target: Everything you need to compile a TI-RTOS library. Supplied in TI-RTOS.

TI-RTOS Closure: Collection of files derived from a TI-RTOS product and a .cfg file. At its essence, the
closure contains TI-RTOS libraries, header files and a linker file. Projects will point to this closure to get
these. The projects that consume a TI-RTOS closure do not need XDCtools or a .cfg file. It still needs the TI-
RTOS product to get the driverlib libraries (and we are trying to fix this also).

Goals

» Learn how to make a TI-RTOS closure based on a specific .cfg file, platform and target.
» Learn how to point your applications to use the TI-RTOS closure.

» Show this for TI/GCC/IAR tool-chains

» Show this for both CCS and IAR IDEs.
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Trade-offs

Advantages of using a TI-RTOS .cfg within your application project?

« Having the .cfg in the application allows TI-RTOS to be fine-tuned for that specific project.
« Easier development flow (the project controls everything).

« Easy to do “What if” scenarios. For example, enable debug features within TI-RTOS.?
Advantages of pointing to a TI-RTOS Closure within your application project

» Faster application builds.

» Application builds do not require XDCtools.

« Having a closure makes having a consistent RTOS configuration across multiple projects easier.

L Even though the .cfg is part of the project, it can be shared across multiple projects.

2 For different “What if” scenarios, you can have multiple TI-RTOS closures (e.g. a full featured
closure, a no debug minimal closure, etc.) that projects can point to and be rebuild against.
Please refer to the “Configuration File Tricks” slide near the end for ways to make a flexible .cfg
file 3

Wi3 TeXAS INSTRUMENTS



Software needed to make the TI-RTOS Closure

These presentation will be focused toward the CC13xx/CC26xx devices but is applicable for other
devices.

You'll need the following software products to make a TI-RTOS closure

— TI-RTOS product (in CCS App Center or here). For the purpose of this document, “TI-RTOS for TI-
RTOS CC13XX and CC26XX 2.16.00.08” will be used.

— Compiler Tools (in IDE or stand-alone)
— XDCtools (shipped in CCS and also in the TI-RTOS product for non-CCS users)

— ClosureExample.zip: Zip includes the two files needed to make an example TI-RTOS closure (files
are described on the next slide).
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http://software-dl.ti.com/dsps/dsps_public_sw/sdo_sb/targetcontent/tirtos/index.html

Example: Files need to make a TI-RTOS Closure

This presentation will use “TI-RTOS CC13XX and CC26XX 2.16.00.08” release and the two files
in ClosureExample.zip to make a TI-RTOS Closure.

- makefile_ccl3xx_cc26xx: Makefile used to build the TI-RTOS closure. Contains paths to the TI-
RTOS product, the .cfg, compiler location, and platform that will be used to build the closure.

- empty_min.cfg: This file is from the CC2650 LaunchPad’s “Empty Min” example in “TI-RTOS for
CC13XX and CC26XX".

Assuming all software is installed as specified on the next slide, these files do not need to be
modified for the example. There will be slides commenting on what would need to be modified for
a different example.

Build Overview

You will use XDCtools to run “gmake —f makefile_cc13xx_cc26xx” to build the TI-RTOS Closure.
The result will be a portable directory that contains the TI-RTOS Closure based off the
information in the makefile.
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Build Closure Step 1: Installing Software Products

For this presentation, it's assumed that the following product are install

Compiler Tools
— CCS6.1.2 s installed in c:\ti.

TI-RTOS
— TI-RTOS CC13XX and CC26XX 2.16.00.08 is installed in c:\ti.

— xdctools_3 32 00 06 isin c:\ti

ClosureExample.zip
— Is extracted into c:\ClosureExample

e

CISCO Mame

ClasureExample . ]
|=| empty_min.cfg

customers ]
|| makefile_ccl 3o oo
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Build Closure Step 2: .cfg file

As noted earlier, the empty_min.cfg is from the CC2650 LaunchPad “Empty Min” example in “TI-RTOS for
CC13XX and CC26XX". Simply use a different .cfg if desired. The name and location of the .cfg is defined at

the top of the makefile (next slide).

|1 H TI-RTOS for CC13XX and CC26XX |
@ Release Notes
@ Documentatien Links
4 :_EF SimpleLink Wireless MCLU
- |# CC1310F128
- ¥ CC1350F128
4 P CC2650F128
. CC2650 Developrment Kit (4X5)
. @0 CC2650 Development Kit (5XD)
. B4 CC2650 Development Kit (71D)
Le_®% CC2650 LaunchPad]
a4 ¥ Driver Bxamples
a %0 T Driver Examples
. %% Display Examples
4 %Y Empty Examples
|ﬂ' Empty (Minimal F'r-:u'ectl
& Empty Project
. %% PIN Examples
. B4 UART Examples
. ¥4 Kernel Examples
. @4 CC2650 SensorTag
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Build Closure Step 3: makefile

=] makefile_cc1%o_co2oc :‘.i]

. . . « . ” 1
The makefile (in this case “makefile_cc13xx_cc26xx”) o § ====———= makefile ccl3xx CC26xx ========
allows the user to set the following 4 #
) . 5 #
Closure Iocatlon & # Destination directory of the TI-RTOS closure
. T #
- Name Of the Cfg flle & CLOSURE DIR ?= c:/empty min closure
- Location of compiler tools 0 ¢
11 # TI-RTOS application configuration file used to make this closure
- Platform name* 12 #

")

APPLICATION CFG FILE ?= ./empty min.cfg

4

- Location of TI-RTOS and XDCtools - .
: : : . 16 # Location of compilers. Leave blank if not used.
- Compiler options (lower in the file) M P
18 TI COMPILER DIR ?= C:/ti/ccse 1 1/ccsve/tools/compiler/ti-cgt-arm 5.2.5
* Same as a TI-RTOS CC2650 LP example 15 IAR COMPILER DIR 2= ci/iar/arm
20
< Preperis o e rin S AONCHL T 200712 L e i 21 %
e Senersl ot 22 # Platform to build
. ::::m c Debug [ Active ] | [Menage ¢ 23 #
e o 24 PLATFORM ?= ti.platforms.simplelink:CC2650F128
Optimization E Main| & RTSC 25
Include Options. =
EAEéR:d—E:SZDDrDA ADCtools version: IEEZODS_LNE v] 26 #
)A»M:dL\‘r:::’EdOplmns =i Products and Repositories | % Order 2—. # TI-RTOS and XDCTOO]_S locations
T N (| Y- M = B,
ey D 1500 — 29 XDCTOOLS INSTALL DIR ?= c:/ti/xdctools 3 32 00 06 core
> [] @k TI-RTOS for MSP43x. = P —_ —_ _ . . . _ — — —
i g:Eiggz:;;?‘.:;pc\emkw\ra\essMtus . 32U TIRTOS_INSTALL_DIR 7= C: /tl/tlrtOS_CC13XX_CC2 6XX_2_1 6_0 0_08
D i
4[]l Other Repositories o
Target: titargets.arm.elf. M3
ti.platforms.simplelink:CC2650F128 - I 8
B prote release =
- Q’ TEXAS INSTRUMENTS




Build Closure Step 4: Build a TI-RTOS Closure

Now that everything is ready, building the TI-RTOS closure is easy!

a. cd into the c:\ClosureExample directory

b. Run the following command “c:\ti\xdctools 3 32 00 06 core\gmake -f makefile _cc13xx_cc26xx ti”

I

C =
C =
C =
C =
C =

“ClosureExample »c:stisxdoctools_3_32_B0_B6_coresgmake —f makefile_cclidxx_ccoc2bix

i

sAtiswdoctools_3_32_BA_B6_coresbinsrm.exe —p»f configPkg
stiswdctools_3_ 32 _B0_06_coresbinsrm.exe —»f spc
stiswdoctools_3_32_AA_B6_coresbhinsrm.exe —»f c:isempty_min_closuresti
Atiswdoctools_3_32_A0_B6_coresbinsmkdir.exe —p c:osempty_min_closure
stiswdoctools_3_32_BAB0_B6_coresxs ——xdepath="c:i sti tirtos_ccldxx_cc2bxx_2_16_8A

spackages;icististirtos_ccoldxx_cco2bxx_2_16_A8_@A8 - -productsstidrivers_ccl3xx_cc2b

oy_2_16_HHA_B8.-packages;c: /tistirtos_ccldxx_cc2bxx_2_16_88_A8 products-hios_6_45

Bl

After a

_2%/packages;cististirtos_coldxx_cc26xx_2_16_H0_B8.-productsuia_2_ HH@_BA5_ _58-pac

couple minutes, you will have a TI-RTOS closure in

c:\empty_min_closureti

To build the TI-RTOS closure with IAR, select the “iar” rule
instead of the “ti” rule. This will make an iar directory similar to the
ti one shown on the right.

O5D0isk (C:) » empty_min_closure » ti »
L —

rary = Share with = Burn Mew folde

Mame

configPkg
src
ti
xdc
1= repoxml
|| compiler.opt

|| compiler.opt

-

defs

|=] empty_min_pem3.rov.xs

5| linker.cmd
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Multiple Closures

You can make multiple closures by having multiple makefiles that generate different
CLOSURE_DIR destinations or a different .cfg file. You can use different platforms or
compiler options also.

The supplied makefile file is meant to be an relatively simple example that can be used
as a template for additional ones as needed.

Now we have our TI-RTOS closure built, let’s point an application at it...

10
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Consume Closure Step 1: CCS Project + TI-RTOS Closure

To consume the TI-RTOS closure, we are going to start with
a simple “Hello World “example (note: that is not from TI-RTOS).

A. Select CCS->Projects->New CCS Project...
Select CC2605F128 Target

“closureTest” as the Project name

Make sure a Tl compiler is selected

Select “Hello World”

And “Finish”

nmoow

Please note, currently there is no simple way to remove
the .cfg from a CCS project that includes a TI-RTOS .cfg file.
That’s why we start with a CCS project without a .cfg file.

CCS Project

Create a new CCS Project.

Target: <select or type filter text>

» | ccassorizs -| l

Connection: lTaasInstruments KDS100v3 USE Debug Probe [Default] v] ’ Verify... l

£ Certex M [ARM]

Broject name: closureTest

Use default location

C\workspaces'ccsb_1_2\closureTest Browse...

Compiler version: ITI v5.2.5

P e

b Advanced settings

w Project templates and examples

type filter text

4 | = Empty Projects -
= Empty Project

5= Empty Project (with main.c)

= Empty Assembly-only Project 3

|y Empty RTSC Project

d Xg o
Hello World

» 1= System Analyzer (UIA) -

Simple Hello World executable application  «
printing the string "Hello World!" to
standard output.

Although this is a simple example, it is not
recommended for devices with small
memaory-maps (such as the M5P430 or
22000 families of devices).

&
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Consume Closure Step 2: CCS Project + TI-RTOS Closure

Here is the resulting project. Note the small CCS(«) on the project icon. Applications that have a
.cfg file are denoted with a small RTSC (&) instead.

[~ Project Explaorer 52 = E v = 8
[ Froj P =

4| closureTest [Active - Debug]
> [pi Includes

= Debug
s [ targetConfigs
» g cc26:0f128.cmd
2 [ hello.c

Now the project needs to be modified to point to the closure in C:\empty _min_closure.

a. Add the following include search paths into the project (CCS->Project->Properties->Build->Arm
Compiler->Include Options) before the codegen include. Make sure the order is as shown!!
c:/ti/tirtos ccl3xx cc26xx 2 16 00 08/products/cc26xxware 2 23 01 16780

c:/empty min closure/ti

Add dir to #Finclude search path (--include_path, -I) @ :D
cx/ftiftirtos_ccl 3we_cc?be 2 16_00_08/products/cc?foovare_2_23 01 16780

cifempty_min_closure/ti 12
"S{CG_TOOL_ROOT} include”

Wi3 TeXAS INSTRUMENTS



Consume Closure Step 3: CCS Project + TI-RTOS Closure

a. Add the following library and linker file into the project (CCS->Project->Properties->Build-

>Arm Linker>File Search Path) before “libc.a”. Make sure the order is as shown!!
C:/ti/tirtos ccl3xx cc26xx 2 16 00 08/products/cc26xxware 2 23 01 16780/driverlib/bin/ccs/dri

verlib.1lib

C:/empty min closure/ti/linker.cmd

b. Add the following library search path in the same window. Make sure the order is as shown!!

C:/empty min closure/ti

" Properties for closureTesf

type filter text

» Resource
General
4 Build
4 ARM Compiler
Processor Options
Optimization
Include Cptions
MISRA-C:2004
ULP Advisor
> Advanced Options
4 ARM Linker
Basic Options
File Search Path
» Advanced Options
ARM Hex Utility [Disabled]
Debug

File Search Path L=T - -

Configuration: |Debug [ Active ] '] [Manage Configurations...]

e EERARY
Ciftivtirtes_ccl Fe_cc2bec 2_16_00_08/products/cc2fcovare_2_23_01_16780/driverlib/bin/ccs/driverlib.lib

Include library file or command file as input (--library, -I)

C:/empty_min_closure/ti/linker.cmd
"libc.a"

& e & 5D

Add <dir> to library search path (--search_path, -i)

C:fempty min closure/ti
"G _TOOL_ROOTYIib"
"G _TOOL ROOTYinclude"
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Consume Closure Step 4: CCS Project + TI-RTOS Closure

IA 4 TI-RTOS for CC13XH and CC26XK |

Let’'s change the example to be exactly like the empty _min in TI-RTOS.
a.
b.

Import the LaunchPad’s empty_min example from TI-RTOS.

F

Copy/paste the following files from this project into the closureTest
(note: do not copy the empty_min.cfg)

Board.h

CC2650 LAUNCHXL.c
CC2650 LAUNCHXL.cmd
CC2650 LAUNCHXL.h
ccfg.c

empty_min.c

em pty_m | n_read me.txt I’ Project Explorer &3

4|5 closureTest [Active - Debug]

Remove the following “old” files from the closureTest ) Includes

= Debu
CC26X0f1280md : Z targethanigs
. . [n| Board.h
main.c - [§ CC2650_LAUNCHXL.c
[ CC2650_LAUNCHXL.cmd

Build and run the example. Example Finished! 8 CC2650_LAUNCHXLR

» L] ccfg.e

- g empty_min.c
= empty_min_readme.td

@) Release Notes
@ Documentation Links
¥ SimpleLink Wireless MCU
- P cc1310F128
- P cc13s50F128
4 W CC2650F128
. B CC2650 Development Kit (4X5)
. B CC2650 Development Kit (5507
. B CC2650 Development Kit (710
L %% 2650 LaunchPad|
a %% Driver Examples
a4 Y TI Driver Examples

. %% Display Examples
a B Empty Examples
L&,_Emr:lt*.r {Minimal) Project |
& Empty Project
. %% PIN Examples
. B4 UART Examples
. B Kernel EBxamples
. B4 CC2650 SensorTag

14
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Debugging: TI-RTOS Source Level Debugging

TI-RTOS Source Level Debugging Option 1

When you build your project, you point the project to the TI-RTOS closure (as noted in the previous slides). However the
source files (e.g. Task.c) are still in the TI-RTOS product. So if you want to step into the source when you are debugging, you
need to point the IDE at the corresponding file in the TI-RTOS product.

For example, a breakpoint was set in xdc_runtime_Gate enterSystem__E. When the breakpoint was hit, the following
message was displayed.

Can't find a source file at "/db/rtree/library/trees/xdcprod/xdcprod-v06/product/xdccore/Linux/xdctools_3_32_00_06_core/packages/xdc/runtime/Gate.c”
Locate the file or edit the source lookup path to include its location,

| View Disassembly... |

Locate File...

To locate, look at the end of the string. It tells you where the file is. Hit the “Locate File...” button and navigate to file (in this
case c:\tilxxdctools_3 32 00 06 core\packages\xdc\runtime). This occurs because the libraries where built on servers within
Texas Instruments and the file information is embedded into the library.

The TI-RTOS generated .c file is still in the closure making directory. For this document’s example, that would be
c:\ClosureExample\configPkg\package\cfg\empty _min_pema3.c. It is not in the generated closure. This file contains small
generated helper functions and TI-RTOS’s malloc/free/calloc/etc. functions.

15
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Debugging: TI-RTOS Source Level Debugging

TI-RTOS Source Level Debugging Option 2

If the following “--filter=0"is added in the closure’s makefile (makefile_cc13xx_cc26xx in this example), all the TI-RTOS source
code is added into the TI-RTOS closure.

2 ti: local clean ti_clean
5 (MEDIR) S {CLC’SURE_DIR}I

74 5({%8) —--=xdcpath="% (XDCPATH)" =xdc.tools.configuroc -v -—-o configPkg Y,
7 -t ti.targets.arm.elf.M3 -p $(PLATFORM) -c $(TI_CCMPILER DIR) Y,
7 —-—compileCptions " ——include path=\"$ (CC2EXXWARE INSTALL DIR)\" -o3

= {l—“&PE’LICRTION_CFG_FILE]I
5(X8) =mdc.tools.closure -v|--filter=0|-d $(CLCOSURE DIR)/ti ./configPkg

The IDE can be pointed at the TI-RTOS source files (including the generated .c file) within the TI-RTOS closure. The
downside of this approach is the size of the non-filtered closure directory (e.g. ~110 MB vs ~30MB for the default).

From a consistency stand-point, pointing to the closure’s source files is preferred if the disk space is acceptable.
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Debugging: ROV

RTOS Object Viewer (ROV)

ROV in CCS will still work, but an extra step is required. When ROV is opened, the XDCtools and TI-RTOS
product must be specified.

" Launch ROV

I.-"'_"‘-.I ADC tools and XDC Path configuration must be specified in the Global Preferences
' before launching ROV.

type filter text RTSC fe=10 4
» General

Changelog
4 Code Composer Studio

Specify the global RTSC configuration and proceed with launch?

The settings selected here will be used during activities not associated with any
particular project. b

» Advanced Tools

Device family: ’
> Build

> Debug Compiler version: ’

4 RTSC RTSC support

Products XDCtools version: [3.32.0.06_core

OQti O n 1 Createrepo

) n:rgia =i Products and Repositories |<}(|} Order|
This can be done in Windows->Preferences and <H ,f s e
. . » Javabcript > B System Analyzer arget; -
select the appropriate versions. » Clmi ThRTOS

mDebug > [] = TI-RTOS Full Release

g Rermnove
. . . - Specfile Editor > [ = TI-RTOS for C2000 =
Please remember to change this if you use a new version Tem Bl pRI0S for O and C261X et Al

of TI-RTOS and/or XDCtools. > Tracing e R | i-wereryy

Platform:

[ Restore Defaults| | Apply 117'

® Show advanced settings [ 0K J ’ Cancel ]




Debugging: ROV

Option 2

Like Option 2 in the TI-RTOS source level debugging on a previous slide, if “--filter=0" is used in the makefile,

useful ROV files are not filtered out. Instead of pointing to XDCtools and TI-RTOS installations, a new

Repository can be made that points to the TI-RTOS closure. Click “Add...’

system and enter “c:\empty_min_closure\ti”.

Please select the product to enable for the project. Alternatively, browse to a repesitery location in the
file-system. To register new products, go to Preferences » Code Composer Studio > RTSC = Products.

Preduct

() Select product: DSP/BIOS 5.421.09

I (@) Select repository from file-system: c:\smpb,r min (IDsure\E Il Browse... ]

| [ cancel |

There is an open bug with this approach. “Constructed” objects
(e.g. Task_construct) are not shown.

Please remember to change this if a different closure directory
IS used.

'« Preferences

type filter text

» General
Changelog
4 Code Composer Studic
» Advanced Tools
» Build
» Debug

Energia

> Help

» Install/Update
» JavaScript

» Library Hover
» Run/Debug

» Specfile Editor
» Team

Terminal
» Tracing

':?:‘ Show advanced settings

', select a repository from the file-

Device family:

Compiler version: l

RTSC support

XDCtools version: l

=\ Products and Repositories | <. 0rder|

. [] =4 T-RTOS

- [] =4 TI-RTOS Full Release

- [ =4 TI-RTOS for C2000

- [C] =4 TI-RTOS for CC13XX and CC26XX

- [C] =4 TI-RTOS for MSP43x =

4| 1.

Add...

Edit...

‘ Remove

- [] = TI-RTOS for SimpleLink Wireless MCL—

> [7] = TI-RTOS for TivaC Select All
) hd Deselect All
v

Target:

Platform:

4

[ Restore Defaults ] [

Apply

)

N

Cancel

]
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Configuration File Tricks

Making a flexible .cfg file

If a .cfg is used for multiple projects, it is sometimes nice to add logic in the .cfg to allow some flexibility. Here are
a few ways to add logic into the .cfg file. Please note, the configuration file is JavaScript.

— Device: The Program.cpu.deviceName can be examined. For example:

if (Program.cpu.deviceName.match (/CC26/)) {
ROM. romName = ROM.CC2650;
}

else if (Program.cpu.deviceName.match (/CC13/)) {
ROM.romName = ROM.CC1350;
}

else {

Program.$logError ("Device not support: " + Program.cpu.deviceName, Program, "cpu.deviceName");

— Toolchain: The Program.build.target variable can be examined. For example:

/* Enable Semihosting for GNU targets to print to CCS console */
if (Program.build.target.S$name.match (/gnu/)) {
var SemiHost = xdc.useModule('ti.sysbios.rts.gnu.SemiHostSupport'):;

19
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Configuration File Tricks

-

. «'s Properties for empty_min_CC2650_LAUNCHXL T CC2650F128 EE
— cfgArgs: In the XDCtools Advanced Options, you can .
: ) . type filter text Advanced Options v~
specify a name/value pair that can be accessed in the .cfg  Resource
H H 1 General i
file. Please note, this feature really not apphcgb[e for a TI- Lo Configurtion: |ReimmaiAdEel <) [Manage Coniguationsa]
RTOS closure. It can be used when the .cfg file include in + ARM Compler
. . > ARM Linker
multlple projects. ARM Hex Utility [Disablec]
4 XDCtools Build cenfiguration file (-b) &
Package Repositories [C] Read infile.tcf in addition to infile.cfg (--tcf)
B . Bacic Option = : :
Here code in the .cfg that accesses the setting [ Configuration sript arguments C-cfoArgs) ___ tfoo3)
if (Program.build.cfgArgs.foo == 3) { ebus Joue propetes () a

m

Exclude packages from compatibility checking (-x)
Additienal compiler options (--compileOptiens) "SICOMPILER_FLAGS}"

[T Treat incomnatihilities as warninas (-w)

@ Show advanced settings oK ] [ Cancel
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Outstanding Items to be added in to this ppt/zip

The following items will be added during late Q1/early Q2 2016. The items are in the expected order of
completion. Please use the TI-RTOS forum (https://e2e.ti.com/support/embedded/tirtos/f/355) for additional
requests or to check on the status of the additions.

IAR Support

Building a TI-RTOS closure with IAR is described, but the steps to consume are not yet. Also viewing source
files and ROV in IAR needs to be detailed.

Other TI-RTOS products
Include steps/files for TI-RTOS TivaC, CC3200, MSP, and C2000 products.

Host Validation

Need to validate with Linux and MacOS. Slight changes in the makefile are expected!

Non-IDE projects

Describe how to build non-IDE projects (e.g. makefile based).

21
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Issues

Pre-2.16.00 Version of TI-RTOS for CC13xx and CC26xx

Do we need to support pre-2.16.00 releases? If so, we need to add some steps to get the PDM libraries
properly. There was a fix in 2.16.00 that addressed this.

Missing Driverlib libraries in TI-RTOS closure

There is an enhancement request to include the driverlib libraries in the TI-RTOS closure. This will allow a
consumer of the TI-RTOS closure to not need the TI-RTOS product.

TIRTOS-434: “Missing Driverlib libraries in TI-RTOS closure”

ROV bug with Closure Repository

When using option 2 to view ROV, some of the constructed objects are not shown. There is a bug opened
against TI-RTOS for this.
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Version

1.0: Initial Version (2/28/2016)
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